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Revisions 

This guide’s title page contains the following identifying information: 

• Version number, which indicates the software version. 

• Print date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent edition, visit the 
following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.  

Table 1 lists new features added for the Configuration Management v 5.0 release. 

Table 1 New features added for Configuration Management 5.0 

Chapter Version Changes 

Chapter 2  5.00 Page 19, Installing the CM AMP Editor, the CM AMP Editor is 
now installed from the HP OVCM Administrator media.  

Chapter 3 5.00 Page 26, Search Filters is a new feature used to manage 
configuration files for server applications. 

Chapter 3 5.00 Page 28, The Verify Phase defaults to On error, continue phase. 
You must set this manually for all other phases and for older 
profiles. 

Chapter 3 5.00 Page 30, Header Information, select the Platform for the profile.  
This will filter which Commands are available in each phase. 
Type a language in Document Header. 

Chapter 3 5.00 Page 30, To create header information, this procedure has 
changed. 

Chapter 3 5.00 Page 33, To add a parameter to a section, you can mark a 
parameter as read only, store it encrypted, and add the 
parameter to the profile’s Utility Class. 

Chapter 3 5.00 Page 35, Creating Search Filters is a new section for complex file 
management. 

Chapter 3 5.00 Page 38, Adding Commands, the following commands have been 
added: Delete data, Exit, Insert/Replace, Save data, Scan, WMI, 
Xquery 

http://ovweb.external.hp.com/lpe/doc_serv/
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Chapter Version Changes 

Chapter 3 5.00 Page 45, Building a String, the following operands have been 
added:  Null, List search element to use, Search result string, 
Search result number, Search result Boolean, Search result 
location, String cell, Number cell, Boolean cell, Number of rows. 

Chapter 3 5.00 Page 45, Building a String, help text is now available 

Chapter 4 5.00 Page 98, the Tools menu has been replaced with the CM 
Configuration Server menu. 

Chapter 4 5.00 Page 97, the Manage All Utility Class Parameters command has 
been added. 

Chapter 4 5.00 Page 98, the Edit CM Configuration Server Connection 
Information command has been added. 

Chapter 4 5.00 Page 98, the Update Class Connection Information command 
been added.  

Chapter 4 5.00 Page 98, To synchronize the Utility Class, the command name 
has changed from Update RCS section from utility class to 
Synchronize Utility Class with this profile. 

Appendix B 5.00 Page 119, Application Management Profiles Standalone Agent is 
a new appendix. It describes a utility to test your profiles. 

 

Table 2 indicates changes made to this document for earlier releases.  

Table 2 Document changes 

Chapter Version Changes 

Chapter 3 1.11.0 Page25, Creating a Custom Application Profile, when creating a 
Profile, a backup file is saved to the operating system’s temp 
directory with a bak extension. 

Chapter 3 1.1 Page 26, Managing Phases, use the Manage phases command to 
delete, modify, add, and change the order of phases. 
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Chapter Version Changes 

Chapter 3 1.11.0 Page 26, Managing Phases, When a Phase is added or modified, 
all fields are checked for completion. 

Chapter 3 1.1 Page 30, Header Information, use Header Information to track 
the version of the profile, list the profile’s features, and list 
assumptions. 

Chapter 3 1.1 Page 33, Configuration Settings, the Add Parameter button has 
been changed to Manage Parameter. 

Chapter 3 1.1 Page 38, Adding Commands, the following commands have 
been added: Loadbalancer interaction, Create directory, 
Remove directory, Rename file, Create file, Change UNIX 
owner/group/permission, Change Windows File/Directory 
Attributes, Verify UNIX File/Directory Attributes, Verify 
Windows File/Directory Attributes, Set Environment Variable. 

Chapter 3 1.11.0 Page 38, Adding Commands, the following commands have 
been added: Create a windows service, Set/Get Values from INI 
file, Generate random numbers, Fetch a URL.  Also, the 
commands are now listed in alphabetical order. 

Chapter 3 1.11.0 Page 39, Cut, copy, and past are available to move commands 
between phases. 

Chapter 3 1.11.0 Page 40, Get an attribute value from a client object, you may 
now use an object in the COP directory (RADSETUP). 

Chapter 3 1.11.0 Page 41, Set an attribute in a client object, you may now use an 
object in the COP directory (RADSETUP). 

Chapter 4 1.1 Page 97, Overriding Values in the AMP (Utility Instances), 
several new Application Management Profiles have been added. 

Chapter 4 1.1 Page 97, Creating the Utility Class, use the CM AMP Editor 
Update RCS section from utility class command to manage the 
application’s Utility class. 

Chapter 4 1.1 Page 98, Creating a Utility Instance, use the CM AMP Editor 
Manage utility instances command to manage Utility instances. 
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Chapter Version Changes 

Chapter 4 1.1 Page 102, Publishing a Profile, use the Publish to Database 
command in the CM AMP Editor to publish the profile. 

Appendix A 1.11.0 Page 115, Environment Variables, this is a new appendix. 
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Support 

You can visit the HP Software support web site at: 

www.hp.com/managementsoftware/services 

This Web site provides contact information and details about the products, services, and 
support that HP Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a 
fast and efficient way to access interactive technical support tools needed to manage your 
business. As a valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract. 

To find more information about access levels, go to: 

www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:  

www.managementsoftware.hp.com/passport-registration.html 

 

http://www.hp.com/managementsoftware/services
http://www.hp.com/managementsoftware/access_level
http://www.managementsoftware.hp.com/passport-registration.html
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1 Introduction 
At the end of this chapter, you will: 

• Be familiar with capabilities of CM Application Management Profiles. 

• Know its terminology. 
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Application Management Profiles 
The HP OpenView Configuration Management Solutions for Servers - 
Application Management Profiles includes a set of tools built on top of HP 
OpenView Configuration Management Application Manager (CM Application 
Manager) to enable the deployment and management of complex software 
products that are typically required on servers in a datacenter environment 
such as Microsoft SQL Server, Oracle, Apache, and Internet Information 
Server among others. These products often employ their own instrumentation 
or repositories for deployment and management of their implementation. 

Application Management Profiles provides tools to: 

• Analyze and parameterize configuration control data for targeted 
products. 

• Specify values in the form of a model to be used at deployment time. 

• Articulate in the model pre-requisites and constraints that qualify the 
ability to deploy the products. 

• Publish the control information and required ancillary tools such as 
utility programs to the HP OpenView Configuration Management (CM) 
infrastructure for deployment. 

• Deploy and configure the software to targeted devices. 

• Interact with the target environment before and after installation to 
enhance management of the deployment. 

• Report on the success of the deployment. 

The intent of this book is to provide instruction on how to deploy server 
applications using these tools. The figure below provides a general workflow. 

 
To use the CM Server Management Agent you must own a Server 
LTU for CM Application Manager. 
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Figure 1 Workflow 

 

Terminology 

The following terms are used in this guide and are specific to Application 
Management Profiles: 

CM Application Management Profile Editor (CM AMP Editor) 

A tool to create and modify Application Profiles. 

CM Server Management Agent 

The software that must be installed on the target device to execute the 
Application Management Profile. 
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Master Application Profile (MAP) 

An XML-based specification of a server application’s installation parameters. 
A parameter in the XML might refer to the installation directory of an 
application. 

Custom Application Profile (CAP) 

A MAP that has been customized to your environment. 

Utility Class 

A class in the HP OpenView Configuration Management Configuration 
Server Database (CM Configuration Server DB) specifically used for a 
particular server application. For example, the Utility Class used for 
Microsoft SQL Server 2000 is called MSSQL2K. 

Audience 
This guide is for administrators of Application Management Profiles. You will 
learn how to use the tools supplied to deploy server applications. 

Prerequisites 
The reader should be familiar with the following products: 

HP OpenView Configuration Management Configuration Server 

HP OpenView Configuration Management Administrator 

HP OpenView Configuration Management Application Manager 

HP OpenView Configuration Management Portal 

 
To use CM the Server Management Agent you must own a Server 
LTU for CM Application Manager. 

Additional Components 

In addition to already established CM products, Application Management 
Profiles use: 
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• Master application profiles for supported applications 

• A set of methods specific to deploy server applications on the target 
device (CM Server Management Agent) 

• The CM Application Management Profiles Editor (CM AMP Editor) to 
administer the profiles 

Chapters Summary 
In addition to this chapter, this book contains the following information 

• Installing Application Management Profiles 

• Packaging server applications 

• Preparing server applications 

Related Documents 
HP OpenView Configuration Management Configuration Server User Guide 

HP OpenView Configuration Management Portal Installation and 
Configuration Guide 

HP OpenView Configuration Management Application Manager Installation 
and Configuration Guide 
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2 Installing Application Management 
Profiles 

At the end of this chapter you will: 

• Know how to install the components needed to use Application 
Management Profiles. 
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Installation Media 
Application Management Profiles requires the following: 

• The CM AMP Editor is installed as part of the CM Administrator. 

• Application Management Profiles contains one subdirectory for each 
provided profile. Each subdirectory includes the profile, a descriptive 
html document, and a Profile Note. 

• The APPMGMT Domain for the CM Configuration Server DB is installed 
by default in the CM Configuration Server 5.00 or above. 

• The target device requires the CM Server Management Agent. See CM 
Server Management Agent. 

 
Note that on 64-bit Windows architectures the agent and 
profiles will run in 32-bit emulation mode. HP recommends 
using fully qualified paths in your profiles to make sure that 
you are able to run 64-bit executables on 64-bit operating 
systems. The agent and profiles may be affected by registry and 
file redirection as documented in the Microsoft knowledge base 
articles, Overview of the compatibility considerations for 32-bit 
programs on 64-bit versions of Windows Server 2003 and 
Windows XP. As always, be sure to thoroughly test your profiles 
before deployment. 

Prerequisites 

Before installing the components on the Application Management Profiles 
media, you will need to complete the following tasks: 

• Designate a CM Configuration Server to host your profiles and policy 
information. 

• Install CM Administrator Configuration Server Database Editor (CM 
Admin CSDB Editor) and CM Administrator Packager (CM Admin 
Packager), components of the HP OpenView Configuration Management 
Administrator (CM Administrator), on a computer designated for 
administration. 

• Install CM Application Manager on your target servers. 

• Install CM Messaging Server. 

• Install CM Reporting Server. 
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All components of the CM infrastructure must come from the 
media for release 5.00 at a minimum unless otherwise noted. 

Platform Support 

For information about the platforms that are supported in this release, see 
the accompanying release notes. 

Installation Process 
After meeting the prerequisites, you will need to do the following: 

• Install CM Configuration Server version 5.00. This is the required 
version. Be sure to check the box for  

• Install the CM Application Management Profiles Editor (CM AMP 
Editor). 

System Requirements for the CM AMP Editor 

The CM AMP Editor is part of the CM Administrator. 

• TCP/IP connection to the CM Configuration Server. 

• Minimum resolution of 800 x 600. 

• For Windows 2000, Server 2003, or XP or Vista, you must have 
administrator rights to the computer to install the CM Administrator. 

Platform Support 

For information about the platforms that are supported in this release, see 
the accompanying release notes. 

Installing the CM AMP Editor 

The CM AMP Editor allows you to modify the profiles provided. The CM AMP 
Editor is a part of the CM Administrator. For convenience, install the CM 
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AMP Editor on the same computer as the CM Admin CSDB Editor and CM 
Admin Packager. From the administrator installation media, click 
setup.exe. Select the CM AMP Editor feature when prompted. 

Figure 2 CM Administrator features 

 

To start the CM AMP Editor 

• From the Start Menu, select the HP OVCM Administrator group. Click 
the icon for CM AMP Editor. 
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3 Packaging Server Applications 
At the end of this chapter you will: 

• Know how to package the installation media. 

• Be able use the CM AMP Editor to create your Custom Application 
Profiles (CAP). 

• Be familiar with how to publish the CAP to the CM Configuration Server 
DB. 



 

22 Chapter 3 

Packaging Server Applications 
To package the server application, you must perform the following tasks: 

1 Package the installation media. 

2 Modify the profile to create your Custom Application Profiles (CAP). 

3 Package the CAP. 

Figure 3 Package the server application 
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Packaging the Installation Media 
You can use the CM Administrator Packager (CM Admin Packager), part of 
the HP OpenView Configuration Management Administrator (CM 
Administrator), to create an installation point or access the media from a 
network share. The Component Selection Mode of the CM Admin Packager 
might be the simplest approach to use. 

To package the installation media using Component Selection Mode 

Use Component Selection Mode to promote the server application’s 
installation media. For complete information on the CM Admin Packager, see 
the HP OpenView Configuration Management Application Manager 
Installation and Configuration Guide. 

 
Be sure that your CM Configuration Server has adequate space for 
the installation media. 

• Copy the installation media to a directory path where the software will be 
installed from on the client computer. If you do not package from this 
directory, you will need to change the Path instance in the CM 
Configuration Server DB. 

• Give the package a meaningful name. 

• Promote the package to the APPMGMT Domain, not the SOFTWARE 
Domain. 

Figure 4 Promote the installation media to APPMGMT Domain. 
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CM AMP Editor 
This tool allows you to make an Application Management Profile available to 
the system for deployment. This interface allows you to: 

• Construct or modify a profile for use with a specific software package. 

• Open a profile for customization from local file system. 

• Create configuration settings. 

• Add commands to be run before, during, and after an installation. 

• Publish the Application Management Profiles to the CM Configuration 
Server DB. 

Master Application Profiles (MAP) will be provided for each supported 
application. These will serve as examples that you can use to create your own 
company specific deployments called Custom Application Profiles (CAP). 

 
At the time of this writing, the CM AMP Editor is available only on 
Windows operating systems. 
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Creating a Custom Application Profile 
Use the CM AMP Editor to create your own Custom Application Profiles from 
the examples provided by HP. The Application Profiles Editor should be 
installed on an administrator computer with access to these files. The 
Application Profiles Editor is organized into tabs. Tabs may vary from one 
application to another. All of the files have a Header Info, Configuration and 
File Templates tab. When creating a Profile, a backup file is saved to the 
operating system’s temp directory with a bak extension. 

Tabs and Phases 

From the File menu of the Application Profiles Editor, open a profile. 

Figure 5 Tabs of CM Configuration Server sample file 

 

Each profile may or may not have the following tabs included: 

• Header Info 
Use this tab to specify the version of the profile, and assumptions, and 
list the profile’s features. 

• Configuration 
Use the configuration tab to edit installation parameters. These values 
can be referred to in commands that you create. 

• File Templates 
Shows the files that the profile will modify on the target computer. 
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• Initialize 
During the Initialize phase, the Application Management Profile Client 
gets information that will be used during the Install Phase. 

• Search Filters 
Use this tab to create search elements to be used on data, such as a result 
of a registry query example, or a text file. 

• Pre-Install 
Specify any commands that you want to run before the installation such 
as turning off anti-virus software or checking for disk space. 

• Install 
Specify the commands to run the installation such as executing the setup 
file or checking if a computer restart is needed. 

• Verify 
Specify the commands to run to verify the application is installed 
correctly. 

• Repair 
Specify the commands to run if the application needs to be repaired 

• Update 
Specify the commands to run to update the application. 

• Delete or Uninstall 
Specify any commands that you want to run when the application is 
removed from the target computer. 

Managing Phases 

The CM AMP Editor allows you to add and manage the phases in a profile. 
When a Phase is added or modified, all fields are checked for completion. 

To add a phase 

1 From the Edit menu, click Manage Phases. 
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2 Click Add Phase. 
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3 Type a Phase name, Display Title, and Description. If needed, select a 
mode for the phase. See Command Modes on page 47 for more 
information. 

4 Select the On error, continue phase check box if you want to be able to 
do all the commands in a phase even if they failed. 

For new profiles, the Verify phase defaults to On error, 
continue phase. For all other phases, you must manually set 
this. In older profiles, you will need to set this as well. 

5 This will ensure that you catch all the anomalies in one attempt as 
opposed to one per attempt 

6 Click Done to confirm the settings. 

7 Click Done when you are finished managing phases. 
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To manage phases 

1 From the Edit menu, click Manage Phases. 

 

2 Click on the action you want to perform. 

— Click Delete to remove a phase. 

— Click Move Up to move a phase up. 

— Click Move Down to move a phase down. 

— Click Modify to change the Phase Name, Display Title, Description, 
or Modes for this phase. 

— Click Add Phase to add a phase. 

3 When you have completed your changes, click Done. 
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Header Information 

Use header information to track versions, authors, and features of 
application management profiles. In addition, you select platforms for the 
profile. This will filter the commands appropriately for your platform. 

In the document header, you can type a language for the profile. 

To create header information 

1 From the Header Info tab, click Header Info. 

2 In the Editor, type in the values you want. 

 

3 From the Platform drop-down list: 

— Select Windows to view only the commands usable in Windows when 
you view the Add Command dialog box. 

— Select Unix to view only the commands usable in Unix when you 
view the Add Command dialog box. 

— Select Any to view all commands no matter what platform you are 
using. 

The header information has been added to the application profile’s xml file. 
You may also do this to add a list of Features and set Assumptions for the 
profile. 
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Configuration Settings 

Create sections of Configuration Settings to construct your Application 
Management Profiles. For each section, create instances with the necessary 
parameters. HP provides a set of sample profiles that you may use to see 
examples of configuration settings. We recommend the following sections: 

• Installation Configuration: Use this for parameters needed during 
installation such as installation drive and directory. 

• Product Configuration: Use this for parameters required for product 
configuration options that can be changed after installation such as 
parameters required for running a service. 

• Security Configuration: Use this to define domain accounts and 
passwords required for installing or running the application. 

• Command Definition: Use for any custom commands you will use in 
multiple phases. 

• Requirement Definition: Use this to specify minimum requirements 
such as free disk space and operating system.  

• Temporary Storage: Use this section for items that are populated from 
local machine information for use in the application management profile. 
Examples would be the operating system’s temporary directory, current 
operating system, and environmental variables. 

• User Credentials: Use this section to create specific user credentials for 
application installation. Not all applications require this. This section is 
invisible by default. 

By design, you will not automatically see a User Credentials 
section in Configuration Settings. To create one, click Add on the 
Configuration settings, and then click New Instance, not New 
Section. 

To add a section to Configuration Settings 

1 From the Configuration tab, click Add underneath the sections box. 
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2 Click New section. 

 

3 Type a Section name, Display title, Description, and Minimum and 
Maximum number of occurrences. In this example, we are creating a 
section for Product Configuration parameters. 

4 Click Save. 

The new section is created. You will need to add parameters to the section. 
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To add a parameter to a section 

1 From the Section, click Manage parameter. 

2 Click Add to add a parameter. If you want to change an existing 
parameter, click Modify. To remove a parameter, click Delete. 

3 Type in a Parameter name, Display title, Description, Default value (if 
needed), Length and Parameter Type. Check the Read only check box if 
you do not want this parameter edited. Check the Store encrypted 
check box to encrypt the parameter. Click Store in utility class to add 
this parameter to the profile’s Utility Class. 

The default encryption for parameters is AES. This requires 
nvdkit minimum build 443 on the CM Server Management 
Agent. 

4 Click Done. 

5 Add as many parameters as you need. 

6 Click Done when you have added all the parameters. 

The parameters are created. Repeat this procedure whenever you need to 
create parameters in this section. When you have finished, you can add 
instances of the section. Validation is performed on saving, opening, and 
deleting a parameter. An hourglass is shown during validation. 

To add an instance of a section 

1 From the Configuration tab, click Add underneath the sections box. 

2 Click New Instance. 

3 Select a section to add an instance, and type an Instance name.  

4 Click Done. 

5 Click the new instance name under its Section in the Section list box. 

6 Type in the required parameters. 

7 Click Next to complete the creation of the new instance. 

The new instance is created. You are now able to refer to this instance in 
your Commands. 
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If there is only one instance of a section, that instance will 
automatically display when you click on the section name. If there 
are multiple instances, the instance names will be nested under 
the Section name. 

File Templates 

The CM AMP Editor allows you to add and delete lines in File Templates, as 
well as add If statements. File templates may be used to modify installation 
files. 

Figure 6 View the File Templates tab 

 

• Click Add line to add a line to the file template. 

• Click Remove line to remove a line from the file template. 

• Click Move Up to move a line up in the file template. 

• Click Move Down to move a line down in the file template. 

• Click Add If block to add an If statement. You will need to include a 
condition, a value if the condition is true, and a value if the condition is 
false. If the false value is not needed, simply highlight the line with the 
<ELSE> and click Remove line. The whole else clause will be removed. 

• To edit a line, double-click that line. 
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Creating Search Filters 

Use the Search Filter tab to create expressions to search for in files in the 
target device. These filters will most likely be used with Search Result 
string, Search Result number, Search Result Location, and the 
Insert/Replace commands. 

 
Starting with version 5.00, the media contains a samples directory. 
This directory contains examples of how to use the search filters. 

Creating Search Filters 

Use the Search Filter tab to define search expressions. These filters can then 
be used to search files or data for specific information. Searching is performed 
using the Scan command. Other related commands are Delete Data, 
Insert/Replace Data, Read File Data and Save Data. 

To create a Search Filter 

1 Click the Search Filter tab. 

2 Click Add. A New Search Element appears. 
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3 Type in a Title and Description for the Search Element. 

4 Click the ellipsis at the end of the Regular Expression drop-down list to 
create an expression to search for. 

5 Click Edit to begin creating your expression. 

6 In the example below, we create a search string of 119. 
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7 Click Update, and then Save. 

8 If the search expression is case-sensitive, check the Case Sensitive box. 

9 From the Instance Number drop-down list, select if you would like to find 
All Matches, just the first match, or just the last match. You can also 
enter a number to find that particular match. For example, type 5 to find 
the fifth match. 

10 If you want to use this Search Filter in the Insert/Replace Data and 
Delete Data commands, you must check the Save Results box. 

11 From the Use drop-down list, select to use either the Matched Data or 
the Captured Groups.   

— Use Matched data to replace all occurrences of a string value with 
another string value. You are not interested in the parts of what you 
find, but rather the whole value. For example, you want to replace 
\\WIN2KSERVER89 with \\WIN2KSERVER34. The parts of the 
value, WIN2K, SERVER and 89, are not relevant. 

— Now, suppose that you still want to find \\WIN2KSERVER89 but 
want to change it to \\WIN2K89SERVER. In this case, you would 
write an expression that searches for these strings and divides them 
up into groups, \\WIN2K, SERVER, and 89. Then, you can switch 
and replace easily because Captured groups lets you reference 
these parts of a search expression individually. 
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12 From the Data Type drop-down list, select the scanned data’s type. 
Below is a complete example. 

 

Adding Commands 

Create commands to further control your installation. Add a command by 
clicking on Add in an application management phase such as Initialize, Pre-
Install, Install, Verify, Update, Repair, or Delete. 

Note that on 64 bit Windows architectures the agent and profiles will run in 
32 bit emulation mode. HP recommends using fully qualified paths in your 
profiles to make sure that you are able to run 64-bit executables on 64-bit 
operating systems. The agent and profiles may be affected by registry and file 
redirection as documented in the Microsoft knowledge base articles, Overview 
of the compatibility considerations for 32-bit programs on 64-bit versions of 
Windows Server 2003 and Windows XP. As always, be sure to thoroughly test 
your profiles before deployment. 

For each command, specify a Command title and a Command description. 
Each command has its own set of parameters that you will need to specify. 
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You can use cut, copy, and paste commands. To do this, right-click the mouse 
on the command you want to perform the action on. Commands can be copied 
to the same phase or another phase. Note that if you copy and paste a 
command into the same phase, the name will be copied as well. You may 
want to change the name of the pasted command to avoid confusion. Be 
aware of any references to other commands in the original phase. 

 
Starting with version 5.00, the media contains a samples directory. 
This directory contains examples of many of these commands. 

You can choose from the following commands. 

Table 3 Commands and Descriptions 

Command Type Description 

Change State of Windows 
Service 

Use this to change the state of a Windows 
Service. For example, you may need to stop a 
Windows Service to install the application, or 
need to restart a service after installation. 

Change UNIX 
owner/group/permission 

Use this command to change ownership, 
group membership, or permissions of an 
existing UNIX file or directory. 

Change Windows 
File/Directory attributes 

Use this command to modify 
readonly/archive/system/hidden 
attributes of an existing Windows file or 
directory. 

Check Registry Use this to check for the existence of a given 
registry entry. Returns a value >0 if found. 
Returns 0 if no entry is found. 

Copy file Specify an existing file to copy. 

Create a windows service Use this to create a Windows service.  
Specify the name of the service, path to its 
executable, and any dependencies.   You can 
also decide if you want the service to have 
the ability to interact with the Desktop. 

Create directory Specify a directory to create. If the 
intermediate directories don't exist, they will 
be created. If the directory already exists, 
then the directory will not be recreated. 

Create File Select a file to create during the phase. 
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Command Type Description 

Delete data Use this command to delete data you find 
using the Search Filter tab. 

Exit Use this to end the current execution of the 
CM AMP agent on the target device. 

External Select this to run an external command. You 
will be required to include all necessary 
information to run the external command. 

Fetch a URL Use this to connect to a URL. Support for 
http proxies and authentication is included. 

File Operations Use this to normalize file names, use the 
appropriate characters for your operating 
system (native), or to delete a file. 

Generate random numbers Use this to generate random numbers with a 
given range of values. You can specify if you 
want the numbers want to be unique. 

Get an attribute value from 
a client object 

Use this to get the value of an attribute from 
a CM object. You will need to specify the 
directory location of the object such as 
Current Application Directory, Object 
Directory, COP Directory or Object Model. 

Get Disk Space Get the amount of disk space on the target 
computer. You have the option of finding 
either total capacity or free disk space. 

Get Registry Value Use this to get the registry value for a 
specify key if there is a value. If not, returns 
an empty string. To check for the existence of 
a registry key, leave the value blank. 

Insert/Replace Use this with Search Filter to insert or 
replace data in a file. 

Loadbalancer interaction Use this to add or remove the application 
from a pool of load balancers. Application 
Management Profiles supports F5 BIG-IP, 
Cisco CSS 11500 Series Content Services 
Switches, and Nortel Application Switch 
Operating System 22.0. 
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Command Type Description 

Network Share Use this to connect or disconnect from a 
network share. If the installation media is 
located on your network, you will need to 
specify a network location and credentials 
before starting the installation. 

Read File Data Use this command to read data from a file on 
the target device and assign the data to the 
command output. The output can then be 
used by other commands. 

Reboot device Use this to Restart, Power Off, Logoff or 
Shutdown the target computer. 

Remove directory Use this command to specify a directory to be 
removed. If the directory does not exist, then 
no action will be taken. 

Rename file Use this command to rename a file. 

Save data Use this command to saves the scanned and 
updated data to disk. 

Scan Scans the data using defined Search Filters. 
The data can be from a file, command output 
or a parameter reference. 

Set an attribute in a client 
object 

Use this to set the value of an attribute of a 
CM Object. You will need to specify the 
directory location of the object such as 
Current Application Directory, Object 
Directory, COP Directory or Object Model. 

Set Environment variable Use this to set an environment variable. See 
Environment Variables, on page 115 for a 
list of possible environment variables. 

Set Parameter Use this to set a parameter’s value for an 
instance from the Configuration tab. 

Set Registry Value Set a value in the Registry using this 
command. 

Set/Get Values from INI 
files 

Use this command to set or get values from 
an ini file. You will need to specify the path 
to the ini file. 
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Command Type Description 

Sleep for seconds and 
milliseconds specified 

Specify a period of time for the process to 
sleep. Use this to create a pause between 
commands processing to allow for command 
clean up. 

Validate files used in a 
manifest 

Use this command to validate files based on 
a list in a file manifest. 

Verify UNIX File/Directory 
Attributes 

Check attributes of an existing UNIX file or 
directory. You can verify the owner, group, 
permissions, accessed time, size, MD5 
signature, or version. Any attribute that is 
left blank will not be checked. 

Verify Windows 
File/Directory Attributes 

Check attributes of an existing Windows file 
or directory. You can verify readonly, system, 
hidden, archive, accessed time, size, MD5 
signature, or version. Any attribute that is 
left blank will not be checked. 

Windows Service Query Use this to find if a Windows Service exists 
or to find if the Service is stopped, started, or 
disabled. 

WMI This command provides WMI query, 
notification, and execute on a local or remote 
device. 

Xquery Run an Xquery to get or set attribute or node 
values in an XML document. 

Pre-Conditions and Post-Conditions 

For each command, you can specify a pre-condition and a post-condition. Use 
these to control the flow of commands. Pre-condition checks allow or prevent 
an action to be run if certain criteria are met. Post-conditions are used to 
abort the entire profile if the status after a command runs does not meet 
certain criteria. Be sure to provide a descriptive error message to show why 
the flow of commands may be modified. This error message is displayed in 
the client computer’s connect.log and in the CM Reporting Server. 
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Using a Pre-Condition 

If the pre-condition is false or not met, the command will not run. The 
command will be skipped, and we will go to the next command in the chain. 
In other words, the command will run only if the pre-condition is true or met. 
In the example below, the pre-condition states that the computer should be 
rebooted only if the Install MSSQL Server command returns a 3010 code. If 
it does, then the computer is restarted.  If the return code is not 3010, then a 
"Reboot not required message" is displayed, and the profile goes to the next 
command, in this case, Restart SQL Server. 

Figure 7 Use a pre-condition. 

 

Using a Post-Condition 

If the post-condition is false or not met, the profile will stop. Suppose that the 
installation requires 350 MB of free disk space. Create a post-condition on 
the Get Disk Space command that will check if the free disk space is more 
than 350 MB. In the example, below the free disk space on the target 
computer is compared to the Free Disk Space parameter in the Requirement 
Definitions section of the Configuration tab. If the target computer has more 
than 350 MB free disk space, then the profile continues. If the target 
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computer has less than or equal to 350 MB free, the profile will stop, and the 
error message "We need at least 350 MB of free space on the installation 
drive to install" will display. 

 
If there is no post-condition, then the profile will go to the next 
command regardless of the result of the command. 

 

Figure 8 Use a Post-condition. 

 

Condition Processing Summary 

The profile will run this command and go to the next command if: 

• There is a pre-condition that is met, the command runs, and there is no 
post-condition. 
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• There is a pre-condition that is met, the command runs, and there is a 
post-condition which is met. 

• There is no pre-condition, the command runs, and there is no post-
condition. 

• There is no pre-condition, the command runs, and there is a post-
condition that is met. 

The profile will skip this command, but go to the next command if: 

• There is a pre-condition that is not met. The post-condition is irrelevant 
in this case. 

The profile will abort, and display the post-condition error message if: 

• There is a pre-condition that is met, and the command runs, but the post-
condition is not met. 

• There is no pre-condition, the command runs, but the post-condition is 
not met. 

The profile will abort, and will not display the post-condition error message if: 

• There is a pre-condition that is met, but the command fails to run. 

• There is no pre-condition, but the command fails to run. 

If the command fails to run, the post-condition is evaluated for 
existence only. The CM Server Management Agent aborts the 
profile. Any error messages that get returned are not part of the 
post-condition. In addition even if a profile stops due to a failing 
post-conditions, the AMP will still execute the commands in the 
Cleanup phase. 

Building a String 

Some of the parameters for a command may require building an argument 
string. To do this, use the String Builder. To start using the string builder, 
click on the ellipsis at the end of a parameter. Depending on the parameter, 
the following operands may be available in the String builder. 

 
If you hover over an item in the Edit box in the String Builder, help 
text will appear at the bottom of the dialog. 
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Table 4 Available operands in the String Builder 

Operand Description 

Client Object 
Reference 

Use to reference a client object.  This may also be 
referred to as an agent object. 

Command 
Output 
Reference 

Use to refer to the output of another command from any 
phase of the application profile. 

Command 
Return 
Reference 

Use to refer to the return code of another command 
from any phase of the application profile. 

Credential 
Reference 

Use this when you need a set of credentials, such as 
connecting to a network share. 

Environment 
Reference 

Use to create an Environment Reference. 

File Content 
Reference 

Use to refer to an entry in the File templates section. 

If block Use this when you will need to branch the expression. 
You will need to provide a condition, a value if the 
condition is true, and a value if the condition is false. 
Note you can create nested If statements. 

List the search 
elements to use 

Use this to select a defined Search Filter 

Null Use this if you want an empty value. 

Number Use this to type in a numeric value. 

Number cell For WMI, a single cell from a table section array if the 
parameter in the section is a string. 

Number of rows For WMI, the number of rows in a table section array. 

Parameter 
Reference 

Use to reference a parameter from the Configuration 
tab. 

Search Result 
string 

Use this if the result of a Scan command using a Search 
Filter returns a string. 

Search Result 
number 

Use this if the result of a Scan command using a Search 
Filter returns a number. 
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Operand Description 

Search Result 
boolean 

Use this if the result of a Scan command using a Search 
Filter returns a boolean. 

Search Result 
location 

Use this as an index if there is more than one search 
result.  For example, if a search returns 5 matches, you 
can specify the third match (3). 

Space Use to add a space to the string. 

String Use this to type in a string of text. 
Note:  If you are creating a string, that has a tab 
character in it, the tab will display as <Tab> in the 
String Builder. 

String cell For WMI, a single cell from a table section array if the 
parameter in the section is a string. 

Command Modes 

Some commands only need to be executed when the client is running in a 
specific mode. The possible modes are create, delete, verify, update, 
and repair. These modes together form life cycle management of an 
application 

This mode is available for the CM AMP agent to use. The mode can be used 
to control when commands and phases are performed. By default, the mode is 
blank; this means that the command or phase would be executed in all the 
life cycle management modes of the CM Server Management Agent. If a 
phase or command has a specific mode defined, the mode would be compared 
with the current life cycle management mode. If the life cycle management 
mode matches the command or phase mode, then the command or phase 
would be executed. Otherwise, the command or phase would be skipped. For 
example, if the command or phase should be executed only when the client is 
doing a create or a verify, then you would select the create and verify modes 
in the Modes for this command section. If the life cycle management mode 
does not match the phase or command mode, then the phase or command 
would be skipped. 

 
If the modes for a phase are only create and delete, then the command 
modes for commands in a phase will also only be create and delete. 
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Command Examples 

The sections below detail some of the commands and how to use the String 
Builder by example. Find these examples in the CM Application Management 
Profiles provided by HP on the Server Management media. For parameters 
and complex parameters within commands, the CM AMP Editor supports a 
minimum length of zero, and will write NULL when no value is entered. 

 
Examples of almost all of the commands are now included in the 
samples directory on the installation media. Some of these are shown 
in this section. 

Change State of Windows Service 

In the procedure below, you will start the Apache Service after installation. 
The Service to start will be specified by creating a parameter reference. You 
can find this in the Install phase. 

To change the state of a Windows Service 

1 In the Add Command dialog box, click Change State of Windows 
Service. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Click on the ellipsis at the end of the Service name field to start the 
String Builder. This is the service you will be changing the state of. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 From the drop-down list, click the section you want to get the parameter 
from. In this case, we select the Service Name from Product 
Configuration Options. 
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8 Click Update, and then click Save. 

9 From the Action drop-down list, click Start. 
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The results of your new command are displayed. 

Change UNIX owner/group/permission 

In the example below, we will change the owner of the media directory during 
the Pre-Install phase of the Oracle profile. 

To change the owner, group, or permission of a UNIX file 

1 In the Add Command dialog box, click Change UNIX 
owner/group/permission. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen of the Change UNIX owner/group 
/permission command displays. 
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4 Click on the ellipsis at the end of the File/Directory Name field to start 
the String Builder. This is the name of the file or directory that you want 
to change. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. Enter the appropriate 
reference. 

 

7 Click Update, and then Save. 

8 Check the box if you want to recurse subdirectories. 
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The results of your new command are displayed. 

Create directory 

In the example below, we will create the BEA Home directory for WebLogic 
during the Pre-Install phase. 

To create a directory 

1 In the Add Command dialog box, click Create directory. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main page of the Create Directory command will display. 

4 Click on the ellipsis at the end of the Directory Name field to start the 
String Builder. This is the name of the directory to create. Note that you 
can also specify an owner, a group, and permissions. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. Select the set of values 
you need. 
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7 Click Update, and then Save. 
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The results of your new command are displayed. 

Create File 

In the procedure below, you will create a configuration file, virtweb.txt, for 
Apache Virtual Web during the Install phase. The file information will be 
retrieved from the File Template. 

To create a file 

1 In the Add Command dialog box, click Create File. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The screen for the Create File command is displayed. 
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4 Click on the ellipsis at the end of the File Name field to start the String 
Builder. This is the file you will be creating. 

5 Click Edit. 

 

6 From the Operands, click File Content Reference. Select the file to 
create. Type a directory and a file name. Check if you want to delete the 
file after use. 

7 Click Update, and then Save. 
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The results of your new command will be displayed. 

Delete Data 

In the example below, we find and delete all occurrences of "119" in a file. 

To use Delete Data 

1 In the Add Command dialog box, click Delete Data. 

2 Type a short, descriptive Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Since we want to find all occurrences of "119", we will select the Specify 
loop reference check box. 

Before using the Delete data command, you must have a Scan 
command which searches for the data you are going to delete. 

5 Click the ellipsis next to Loop Reference to build an argument string. 

6 Click Add to begin creating the Search Result Loop reference to your 
Scan command. 
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7 Click Update and Save when you are finished. 

8 Click the ellipsis after Search Location to set your search location. 

9 Set the Command Output Type. 
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The results of your new command are displayed. 

External 

In the example below, we need to run an external command. This command 
runs the installation for Microsoft Internet Information Server during the 
Install phase. 

To use an external command 

1 In the Add Command dialog box, click External. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Click on the ellipsis at the end of the Command field to start the String 
Builder. This is the external command you want to run. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 Click Update, and then Save. 

8 Click on the ellipsis at the end of the Arguments field to start the String 
Builder. Set all arguments for the external command here. 

9 Click Update, and then Save. 

10 Check if you want to wait for the command to end. 

11 If needed, select a Working Directory, Output File, and user credentials. 
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12 Click Update, and then Save in the String Builder after you have edited 
all needed fields. 

 

The results of your new command will be displayed. 

File Operations 

In this example, we want the remove the configuration file for Apache as part 
of the Delete phase. 

To perform a file operation 

1 In the Add Command dialog box, click File Operations. 
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2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main page of the File Operations command is displayed. 

4 From the Operation drop-down list, select the operation you wish to 
perform. 

5 Click on the ellipsis at the end of the File name field to start the String 
Builder. This is the file name you will be performing the operation on. 

6 Click Edit. 

7 From the Operands, click Parameter Reference. 

8 From the drop-down list, click the section you want to get the parameter 
from. 

 

9 Click Update, and then click Save. 
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The results of your new command will be displayed. 

Get Disk Space 

In the procedure below, you will check a drive to see if it has adequate space 
for the installation of Microsoft Internet Information Server. The drive will 
be specified by creating a parameter reference to a directory path. Then, the 
drive where the directory resides will be checked. 

To get disk space information 

1 In the Add Command dialog box, click Get Disk Space. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Click on the ellipsis at the end of the Drive Letter field to start the String 
Builder. This is the drive or path on the drive you will be checking. 

5 Click Edit. 

6 Click Parameter Reference. 
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7 Click Update, then click Save. 

8 From the Type drop-down list, click Free. 
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The results of your new command will be displayed. 

Get Registry Value 

In the procedure below, you will fetch a registry value to get the installation 
path for Microsoft Windows. This is required for the installation of Microsoft 
Internet Information Server. 

To get a registry value 

1 In the Add Command dialog box, click Get Registry Value. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 



 

68 Chapter 3 

 

4 Click on the ellipsis at the end of the Key field to start the String Builder. 
This is the key you will be getting the information from. 

5 Click Edit. 

6 From the Operands, click String. 

7 Type the full path to the registry key you are fetching the value from. 

8 Click Update, and then Save. 

9 Click on the ellipsis at the end of the Value field to start the String 
Builder. This is the registry value you will be getting. 
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10 Click Update, and then Save. 

11 The results of your new command will be displayed. 
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Insert/Replace Data 

In the example below, we will replace all occurrences of "119" with "120" in a 
hosts file. 

To use Insert/Replace data 

1 In the Add Command dialog box, click Insert/Replace Data. 

2 Type a short, descriptive Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Since we want to find all occurrences of "119", we will select the Specify 
loop reference check box. 

Before using the Insert/Replace data command, you must have a 
Scan command which searches for the data you are going to 
replace. 

5 Click the ellipsis next to Loop Reference to build an argument string. 

6 Click Add to begin creating the Search Result Loop reference to your 
Scan command. 
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7 Click Update and Save when you are finished. 

8 Click the ellipsis after Search Location to set your search location. 

9 In the Option drop-down list, select if you want to overwrite the data, 
insert in the beginning, or insert in the end. 

10 Type the Data you want to replace with. 

11 Set the Command Output Type. In this case, we use string. 
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The results of your new command are displayed. 

Network Share 

In the procedure below, we need to connect to a network share to install 
Microsoft SQL Server. Credentials must be supplied during the Install phase. 

To specify information for a network share 

1 In the Add Command dialog box, click Network Share. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main page of the Network Share command is displayed. 

4 Click on the ellipsis at the end of the Share Name field to start the String 
Builder. This is the parameter you will be setting the value for. 
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5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 From the drop-down list, click the section you want to get the share name 
from. 

8 Click Update, and then Save. 

9 From the Action drop-down list, click Connect or Disconnect. In this 
case, we want to connect. 

10 Click on the ellipsis at the end of the Credentials field to start the String 
Builder. These are the set of credentials you will use to connect to the 
network share. 

11 Click Edit 

 

12 Click Update, and then Save. 
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The results of your new command will be displayed. 

Reboot device 

In this example, we will restart the target computer. Note that this contains 
a pre-condition to see if a reboot is needed. This example is from the Install 
phase of the Microsoft SQL Server profile. 

To reboot a device 

1 In the Add Command dialog box, click Reboot device. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main page of the Reboot device command is displayed. 

4 From the Type drop-down list, click the type of reboot you want. Your 
options are Restart, Power Off, Logoff, and Shutdown. 
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The results of your new command are displayed. 

Remove Directory 

In the example below, we remove the domain directories during the Uninstall 
phase of BEA WebLogic. 

To remove a directory 

1 In the Add Command dialog box, click Remove directory. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen of the Remove directory command is 
displayed. 

4 Click on the ellipsis at the end of the Directory Name field to start the 
String Builder. This is the name of the directory to remove. 



 

Packaging Server Applications 77 

5 Click Edit. 

6 From the Operands, click Parameter Reference. Select the set of values 
you need. 

7 Click Update, and then Save. 

 

8 Check the box to delete subdirectories. 
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The results of your new command are displayed. 

Scan 

In the example below, we scan for "119" in a file. Usually, this command is 
used before Delete Data, Insert/Replace or Save data. Note that you need to 
define a Search Filter before using this command. 

To use Scan 

1 In the Add Command dialog box, click Scan. 

2 Type a short, descriptive Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Click the ellipsis next to Search ID to build an argument string. 

5 Click Edit. 

6 Select the List search elements to use operand. 

7 From the Search Filter drop-down list, select your search filter. In this 
example, we had already defined "Search for 119" in the Search Filters 
tab. 
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8 Click Update and Save when you are finished. 

9 From the Scan mode drop-down list, select if you want to search by line or 
treat the data as a single block. 

10 If you need the data found to be saved after the program ends then 
enable the save option. Usually, the scanned result data is only available 
during the execution of the program so that other commands can use it. 
The results are deleted when the program ends.  

11 Click the ellipsis after File name to set the file to be scanned. The data to 
scan can be from a file, parameter reference, or command output. 
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The results of your new command are displayed. 

Set Parameter 

In the procedure below, you will set the Media Directory for installation using 
the Set Parameter Command. This example is from the Install phase of the 
Oracle profile. 

To set a parameter from a Client Object 

1 In the Add Command dialog box, click Set Parameter. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 



 

82 Chapter 3 

3 Click Done. The main screen for the Set Parameter command will 
display. 

4 Click on the ellipsis at the end of the Parameter name field to start the 
String Builder. This is the parameter you will be setting the value for. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 From the drop-down list, click the section you want to get the parameter 
from. In this case we select Installation Configuration, the default 
instance, and Install Media Directory. 

8 Click Update, and then Save. 

9 Click on the ellipsis at the end of the Value field to start the String 
Builder. This is the value you will be setting the parameter to. 

10 Click Edit. 

11 Enter the required information. ZDSPM000 is a single instance copy of 
an object that is currently running a method such as CREATE. This 
allows the current method to reference information about the instance 
that spawned it. The current method does need to know the details of the 
original object, such as the object name or instance number that contains 
the specific instance data. In this example, ZDSPM000 tells us the 
MEDIADIR. 

12 Click Update, and then Save. 

The results of your new command will be displayed. 

Set Registry Value 

In the example below, the media directory for Windows must be reset in the 
registry. This is required in the Install phase for Microsoft Internet 
Information Server. 

To set a registry value 

1 In the Add Command dialog box, click Set Registry Value. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen for the Set Registry Value command will 
display. 
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4 Click on the ellipsis at the end of the Key field to start the String Builder. 
This is the key you will be getting the information from. 

5 Click Edit. 

6 From the Operands, click String. 

7 Type the full path to the registry key you are going to set. 

8 Click Update, and then Save. 

9 Click on the ellipsis at the end of the Value field to start the String 
Builder. This is the registry value you will be setting. 

10 Click Edit. 

11 From the Operands, click String. 

12 Type the value you are going to set. 

13 Click Update, and then Save. 

14 Click on the ellipsis at the end of the Data field to start the String 
Builder. This is the data you will set the value to. 

15 Click Edit. 

16 From the Operands, click Parameter Reference. In this case, we are 
setting the Source Directory to the Media Directory. 

17 Click Update, and then Save. 

18 From the Type drop-down list, select the data type. 

The results of your new command will be displayed. 

Verify UNIX File/Directory Attributes 

In the example below, we will use this command to check the existence of the 
WLST files. These are a requirement for the installation of WebLogic Server. 

To verify the attributes or existence of a UNIX files or directory 

1 In the Add Command dialog box, click Verify UNIX File/Directory 
Attributes. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen of the Verify UNIX File/Directory Attributes 
is displayed. 
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4 Click on the ellipsis at the end of the File/Directory Name field to start 
the String Builder. This is the name of the file or directory to check. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

 

7 Click Update, and then Save. 

8 In the Type drop-down list select if this is a file or a directory. In this 
case, we are checking file. 

9 Edit the attributes as needed. 

 
If no attributes are specified, only the existence of the file or 
directory will be checked. 
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The results of your new command are displayed. 

Verify Windows File/Directory Attributes 

In the example below, we will check the existence of the WLST file for 
Weblogic for Windows. This is part of the Install phase. 

To verify the existence or attributes of a Windows file 

1 In the Add Command dialog box, click Verify Windows File/Directory 
Attributes. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen for Verify Windows File/Directory is 
displayed. 

4 Click on the ellipsis at the end of the File/Directory Name field to start 
the String Builder. This is the name of the directory to remove. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 
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7 Click Update, and then Save. 

8 In the Type drop-down list select if this is a file or a directory. In this 
case, we are checking a directory. 

9 Edit the attributes as needed. 

 
If no attributes are specified, only the existence of the file or 
directory will be checked. 

 

The results of your new command are displayed. 

WMI Commands 

The WMI command has three options, WMI Query, WMI Notification, and 
Execute Method. The command examples are supplied below. 

Execute Method 

Use the Execute Method option to execute a method defined in a WMI object. 
IN the example below, we will run a method on the target device. 

To use the WMI Execute Method Option 

1 In the Add Command dialog box, click WMI. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 From the Option drop-down list, click Execute Method. 

 

5 Click on the ellipsis at the end of each of your required parameters. They 
are described below. 

— Object: Enter a WMI object for which you would like to execute the 
method, for example, Win32_Process. 

— Method: Name of the method to execute from the WMI object. 

— Input Parameters: Enter a list of strings with the first element 
describing the parameter name, and the second its value. These 
parameters will be passed to the method being executed 

— Namespace: Enter a namespace, usually root\CIMV2. 

— Server: Enter a fully qualified server name. The default value of "." 
means the local computer 

— Credentials: If the WMI query requires a user and password when 
running remotely, then you can provide the credentials for the 
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resource. The Credentials are created in the Credentials section in 
the Configuration tab. Select a credential instance from the list. If the 
list is empty, create the Credentials element first. 

— Table: A WMI query/notification/execMethod can return multiple 
rows of data. To access the individual properties of WMI result 
Objects, you need to configure a section that allows you to define the 
column headings and the column type. This can be done by defining a 
new section in ConfigSpace and marking it as a table. Select an entry 
from the list that matches your table definitions. If you want to 
ignore the result set, select No Table. 

6 Check Save results if you would like to save the data for future 
reference when the program is run again at a later time. The WMI 
results are available during the execution of the Server Management 
Agent; when the program ends, the results are discarded by default. 

 

The results of your command are displayed. 
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WMI Notification Method 

Use the Notification Method option to be notified when certain events occur. 

To use the WMI Notification Method Option 

1 In the Add Command dialog box, click WMI. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done.  

4 From the Option drop-down list, click WMI notification. 

 

5 Click on the ellipsis at the end of each of your required parameters. They 
are described below. 

— Query: Enter a query in the Windows Query Language format. 

— Namespace: Enter a namespace, usually root\CIMV2. 
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— Server: Enter a fully qualified server name. The default value of  "." 
means the local computer 

— Credentials: If the WMI query requires a user and password when 
running remotely, then you can provide the credentials for the 
resource. The Credentials are created in the Credentials section in 
the Configuration tab. Select a credential instance from the list. If the 
list is empty, create the Credentials element first. 

— Table: A WMI query/notification/execMethod can return multiple 
rows of data. To access the individual properties of WMI result 
Objects, you need to configure a section that allows you to define the 
column headings and the column type. This can be done by defining a 
new section in ConfigSpace and marking it as a table. Select an entry 
from the list that matches your table definitions. If you want to 
ignore the result set, select No Table. 

6 Check Save results if you would like to save the data for future 
reference when the program is run again at a later time. The WMI 
results are available during the execution of the Server Management 
Agent; when the program ends, the results are discarded by default. 
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The results of your command are displayed. 

WMI Query Method 

Use the WMI Query Method option to run a WMI Query. 

To use the WMI Query Method Option 

1 In the Add Command dialog box, click WMI. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 

4 From the Option drop-down list, click WMI Query. 
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5 Click on the ellipsis at the end of each of your required parameters. They 
are described below. 

— Query: Enter a query in the Windows Query Language format. 

— Namespace: Enter a namespace, usually root\CIMV2. 

— Server: Enter a fully qualified server name. The default value of "." 
means the local computer 

— Credentials: If the WMI query requires a user and password when 
running remotely, then you can provide the credentials for the 
resource. The Credentials are created in the Credentials section in 
the Configuration tab. Select a credential instance from the list. If the 
list is empty, create the Credentials element first. 

— Table:  A WMI query/notification/execMethod can return multiple 
rows of data. To access the individual properties of WMI result 
Objects, you need to configure a section that allows you to define the 
column headings and the column type. This can be done by defining a 
new section in ConfigSpace and marking it as a table. Select an entry 
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from the list that matches your table definitions. If you want to 
ignore the result set, select No Table. 

6 Check Save results if you would like to save the data for future 
reference when the program is run again at a later time. The WMI 
results are available during the execution of the Server Management 
Agent; when the program ends, the results are discarded by default. 

 

The results of your command are displayed. 

Xquery 

Run an Xquery to get or set attribute or node values in an XML document. 
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To perform an Xquery 

1 In the Add Command dialog box, click Xquery. 

2 Type a short, descriptive Title, and an explanatory Description. 

3 Click Done. 

 

4 Click on the ellipsis at the end of the File Name field to start the String 
Builder. This is the file will be getting the information from. 

5 Click Edit. 

6 From the Operands, click String. 

7 Type the full path to the registry key you are fetching the value from. 

8 Click Update, and then Save. 

9 Edit any other parameters you require. 

10 Click Update, and then Save. 

The results of your new command will be displayed.
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4 Preparing Server Applications 
At the end of this chapter, you will: 

• Be familiar with Utility Classes. 

• Know how to create a Service Instance for a server application. 

• Be able to connect all required packages to the Service Instance. 
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Prepare the Package 
After packaging the media and creating the CAP, you will need to prepare 
the application for deployment. Use the CM AMP Editor to perform the 
following tasks. 

1 Create a Utility instance for the Server Application 

2 Publish the CAP. 

3 Create a Service instance in the CM Configuration Server DB. 

4 Connect the media package and utility instances to the Service. 

Figure 9 Workflow 
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Overriding Values in the AMP (Utility Instances) 
Utility Classes in the CM Configuration Server DB are used to create server 
specific overrides for the CAP. Use the Utility instance for a Server 
Application to override values in the Custom Application Profile. This allows 
you to use one profile with small variations for each target computer in your 
enterprise. Use the CM AMP Editor to create and modify Utility instances. 

Creating the Utility Class 

Use the CM AMP Editor Synchronize Utility Class with this profile 
command to synchronize the RCS Section of the AMP with the appropriate 
Utility Class on the Configuration Server. 

 
Be sure to check Store in configuration server section in the Manage 
Parameters dialog box. You must do this to add the parameter to the 
Utility Class. To view all parameters that have this checked, use the 
CM Configuration Server menu’s, Manage All Utility Class 
Parameters command. 

• If there is an RCS section in the AMP and no corresponding Utility Class 
in the CM Configuration Server DB, then the Utility Class will be created 
on the Configuration Server based on the RCS section in the AMP. 

• If there is no RCS section in the AMP and a corresponding Utility Class 
in the CM Configuration Server DB, then the RCS section will be added 
to the AMP based on the Utility Class. 

• If there is an RCS section in the AMP and a corresponding Utility Class 
in the CM Configuration Server DB, then the new and updated fields 
from the RCS section will be merged into the Utility Class in the CM 
Configuration Server Database.   Change management processes must be 
followed explicitly.  We do not advise using the CM AMP Editor against 
production databases.  Use the CM AMP Editor against test or 
development CM Configuration Server Databases. 

Before you can synchronize the Utility Class, you must establish your CM 
Configuration Server, and the Utility Class the profile will connect to. 
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To connect to a CM Configuration Server 

1 From the CM Configuration Server menu, click Edit CM Configuration 
Server Connection Information. This includes the CM Configuration 
Server IP address, port, userid, and password. 

2 Type in all information to connect to your CM Configuration Server. 

3 Click Save. 

To connect to a Utility Class 

1 From the CM Configuration Server menu, click Update Class 
Connection Information. 

2 Type in a name for the Utility Class. It must be eight characters or less. 

3 Click Save. 

To synchronize the Utility Class 

1 Select the Synchronize Utility Class with this profile command from the 
CM Configuration Server menu. 

If the Utility Class does not exist on the CM Configuration Server DB, 
you will be asked to create it. If it does exist but there are differences, you 
will be prompted with the changes and asked to accept them. 

2 Click Yes to create the class. 

3 The class is created. Click OK. 

Creating a Utility Instance 

In the example, below we will create a Utility instance to override the Oracle 
Instance name. 

To create a Utility instance 

1 From the tools menu, click Manage utility instances. 
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2 Click Save to confirm the CM Configuration Server Settings. 

3 Click Add to add an instance. If an instance already exists, you can delete 
or modify it. 

 
When you modify an instance, the values that are inherited 
from the base instances will be displayed in red and "**" will 
precede the name of the variable. 

In this example, we create an instance called ORASVR_FINANCE for a 
computer called FINANCE and change the ORASID to FINANCE. 
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4 Click Done. The instance appears at the top of the dialog box. 
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5 When you have finished adding, modifying, or deleting Utility instances, 
click Done. 

If a value exists in the Utility Class, the value is used instead of the value in 
the CAP. Use _NONE_ to tell the CM Server Management Agent that this 
variable has no value in the CM Configuration Server DB and the values 
from the CAP should be used. 

Naming and Connecting the Utility Instance 

There are multiple methods for connecting the Utility instance. The Utility 
instance for an AMP is specified when you create a new Service in the 
Override value during publishing of the AMP. (If you are using the CM 
Admin CSDB Editor this corresponds to the ZSERVICE OVERRIDE 
attribute.) Decide on the method that best suits your needs. Then, you will 
need to use the appropriate naming convention for the Utility instance. The 
most common methods are described below. 
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If you do not have a valid Utility instance, the installation will fail. 
The agent methods for executing the installation of the server 
applications are part of the Utility instance. 

• Multiple computers with identical configurations 

— Use a descriptive name for the Utility instance. For example, create a 
DEMOWEB instance in the VIRTWEB Class. 

— OVERRIDE Value: APPMGMT.VIRTWEB.DEMO_WEB 

• Each computer with one configuration 

— Create one instance for each target computer in the Utility Class. For 
example, create two instances in the APPMGMT.APACHE2 class. 
One named SRV020, and the other named SRV850. When the service 
is deployed, SRV020 will use APACHE2.SRV020. SRV850 will use 
APACHE2.SRV850. The computer name is taken from the ZUSERID 
attribute of the ZMASTER object. 

— OVERRIDE Value: APPMGMT.APACHE2.&(ZMASTER.ZUSERID) 

• One computer with multiple instances of the same application 

— Use this naming method when an application supports multiple 
instances, such as Microsoft SQLServer or Oracle. These server 
applications allow for multiple instances of the application on one 
computer. 

— Name the Utility instance using the name of the computer followed 
by a descriptive suffix. For example, create three instances in the 
APPMGMT.MSSQL2K Class, SQLSRV_FINANCE, SQLSRV_HR, 
SQLSRV_DEV. In each of these instances, set the MSSQL2K. 
INSTNAME to a different value, such as FINANCE, HR, and DEV. 
Leave the other attributes at the _NONE_ value so the Application 
Management Profile’s values will be used. When the service is 
deployed to SQLSRV, Microsoft SQL Server will be deployed with 3 
named instances. 

— OVERRIDE Value: 
APPMGMT.MSSQL2K.&(ZMASTER.ZUSERID)_* 

Publishing a Profile 
After you have created your CAP, you are now ready to promote it to the CM 
Configuration Server DB. During the publishing process, the CM AMP Editor 
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will rename the CAP to control.xml, create an Application (ZSERVICE) 
instance, connect the ZSERVICE to the designated media packages, and 
allow you to modify the connection to the Utility instance. 

To promote an Application Management Profile  

1 From the CM AMP Editor, select CM Configuration Server → Publish to 
Database. 

 

2 If this is the first time that you are publishing in the CM AMP Editor 
session, you will be asked to confirm the CM Configuration Server 
settings. 

3 Verify the CM Configuration Server setting, and click Save. 
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4 Type in the required data for the package information, and click Next. 
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5 Choose one of the following actions: 

— Click Create New to create a new Application (ZSERVICE) instance 
in the APPMGMT domain. 

— Click Use existing to connect to an existing Application (ZSERVICE) 
instance.  If you use an existing service, the Override value will resort 
to the original default, and will add the xml package to the 
ZSERVICE connection.  If you have had a non-default value when 
you originally created the service, be sure to change it if required. 

 
Services should not be reused in production Do not use the CM Amp 
Editor on a CM Configuration Server Database that is in production. 

— Click No service to publish the Application Management Profiles 
only. You will need to connect it to an Application (ZSERVICE) 
instance using CM Admin CSDB Editor. 

In this example, we will create a new Application (ZSERVICE) instance. 
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The Override connects to an instance of the Utility Class. For 
more information on creating the Utility Class and instances, 
see Overriding Values in the AMP (Utility Instances) on page 
97. 

Type in the appropriate values and click Next. 

 

6 All instances in the Application Packages (PACKAGE) class will be listed. 
Select the packages to connect to the Application (ZSERVICE) instance in 
addition to the Application Management Profiles, and click Next. 

7 Click Publish. Status will appear in the dialog box. 
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8 Click Done after publishing is complete. 
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5 Managing and Reporting 
At the end of this chapter you will: 

• Know how to install the CM Server Management Agent. 

• Be able to view reports using the CM Reporting Server. 
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CM Server Management Agent 
The files required to execute Application Management profiles on a target 
device are part of the CM Server Management Agent. CM Server 
Management Agent must be installed on any target computer that you want 
to deploy server applications to. The CM Server Management Agent logs the 
nvdkit and agent versions as well as the header information from the profile 
in use in the connect.log, located in the log directory. 

 
To use the CM Server Management Agent, you must own a Server 
LTU for CM Application Manager. 

Install the CM Server Management Agent from the installation media. For 
installation instructions and system requirements, refer to the HP OpenView 
Configuration Management Application Manager Installation and 
Configuration Guide (CM Application Manager Guide) for Windows or Unix. 

 
Note that on 64 bit Windows architectures the agent and profiles will 
run in 32 bit emulation mode. HP recommends using fully qualified 
paths in your profiles to make sure that you are able to run 64-bit 
executables on 64-bit operating systems. The agent and profiles may 
be affected by registry and file redirection as documented in the 
Microsoft knowledge base articles, Overview of the compatibility 
considerations for 32-bit programs on 64-bit versions of Windows 
Server 2003 and Windows XP. As always, be sure to thoroughly test 
your profiles before deployment. 

Reporting 
Application Management Profiles uses the HP OpenView Configuration 
Management Reporting Server (CM Reporting Server) for deployment status. 
CM Reporting Server version 5.00 is the minimum version required. To use 
CM Reporting Server with Application Management Profiles, the CM 
Messaging Server and the CM Reporting Server must be configured.  

Before performing these steps, be sure that you have set up a database to 
store the Application Management Profiles data and that, on the CM 
Messaging Server and CM Reporting Server, there is an ODBC connection to 
that database. 
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Implementation Details 

Refer to the HP OpenView Configuration Management Reporting Server 
Installation and Configuration Guide (CM Reporting Server Guide) for 
information on installing the CM Reporting Server and the HP OpenView 
Configuration Management Messaging Server Installation and Configuration 
Guide (CM Messaging Server Guide) for information on installing the CM 
Messaging Server. You must perform the additional steps listed in this 
section to enable the Application Management Profiles reports. 

CM Messaging Server Installation 

1 At the Select Data Delivery Agent window of the CM Messaging Server 
installation, select Load the core.dda module to post Core objects via 
ODBC. This will enable the posting of data to an SQL database or an 
Oracle database for the Server Management Reports. 

 
This information is also included in the CM Messaging 
Server Guide. 

2 When prompted, enter the DSN information. 

3 Continue with the installation, following the instructions on the 
remaining dialog boxes. 

CM Reporting Server Installation 

1 After installing the CM Reporting Server, go to 
http://<reportingserveripaddress>/reportingserver/setup.tcl 

2 Click Inventory Manager Configuration. 

3 Type in your DSN information in the RIM DSN, RIM DSN User, and 
RIM DSN Password boxes. 

4 Server Management Configuration (SCM). 

5 For Enable SCM Reports, select 1. 

6 Click Apply and follow the on-screen directions. 

Viewing the Reports 

To view the reports, use an internet browser to go to your CM Reporting 
Server address. Then, click Server Management Reports to view the list of 
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Application Management Reports. Two reports are provided, Job Status by 
Device and Job Status by Service. 

Figure 10 Application Management Profile Reports 

 

• Job Status by Device 
Use this report to see the status of jobs by device name. The report 
includes information on status, reboots, and time of the last job’s start 
and end time. 

 

— Click Successful to view the successful jobs for the device. 

— Click Warning to see warnings associated with this device 

— Click Reboot Pending to see the jobs that require a reboot for 
completion. 

— Click Failed to see the list of failed jobs for this device. 

— Click Total Jobs to see the list of all jobs for this device. From within 
this report, you can drill down further to see detailed information for 
each job including installation parameters used. 

• Job Status by Service 
Use this report to see the status of jobs by Service name. The report 
includes service description, information on status, reboots, and time of 
the last job’s start and end time. 
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— Click Devices to see the list of devices that received this service. 

— Click Successful to view the successful jobs for the service. 

— Click Warning to see warnings associated with this service. 

— Click Reboot Pending to see the services that require a reboot for 
completion. 

— Click Failed to see the list of failed jobs for this service. 

— Click Total Jobs to see the list of all jobs for this service. From within 
this report, you can drill down further to see detailed information for 
each job. 
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A Environment Variables 
In addition to the standard platform-specific environment variables, such as 
windir=C:\WINDOWS for Windows Operating systems, there are AMP specific 
environment variables which are listed below. The APPMGMT environment 
variables, like other environment variables, are usually used in environment 
references for pre and post conditions. You may also want to set a local 
variable to the value of an environment variable. 

List of Environment Variables 

• APPMGMT_BYTEORDER Byte Order 

• APPMGMT_MACHINE Processor 

• APPMGMT_OS Operating System 

• APPMGMT_OSCOMMONNAME Common Name of OS  

• APPMGMT_OSSSERVICEPACK Windows Service Pack 

• APPMGMT_OSVERSION Operating System Version  

• APPMGMT_PLATFORM Platform 

• APPMGMT_HOSTIP Host IP address 

• APPMGMT_HOSTNAME Fully qualified name of the machine 

• APPMGMT_PID Process Id of AMP agent 

• APPMGMT_STANDALONE If the AMP agent is running under the CM 
Application Manager agent the value is N, otherwise it is running 
standalone and the value will be Y. 

• APPMGMT_PHASE_NAME Phase name, that the AMP is currently 
executing 

The following are examples of Windows XP values: 

• APPMGMT_BYTEORDER = littleEndian 

• APPMGMT_MACHINE = intel 

• APPMGMT_OS = Windows NT 

• APPMGMT_OSCOMMONNAME = Windows XP 
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• APPMGMT_OSSERVICEPACK = Service Pack 1 

• APPMGMT_OSVERSION = 5.1 

• APPMGMT_PLATFORM = windows 

• APPMGT_HOSTIP = 192.168.0.11 

• APPMGMT_HOSTNAME = LBLACK.americas.foods.com 

• APPMGMT_PID = 1800 

• APPMGMT_STANDALONE = Y 

• APPMGMT_PHASE_NAME = install 

The following are examples of Red Hat Linux values: 

• APPMGMT_BYTEORDER = littleEndian  

• APPMGMT_MACHINE = i686 

• APPMGMT_OS = Linux 

• APPMGMT_OSCOMMONNAME = Linux 2.2.14-5.0smp 

• APPMGMT_OSSSERVICEPACK = N/A 

• APPMGMT_OSVERSION = 2.2.14-5.0smp 

• APPMGMT_PLATFORM = unix 

• APPMGT_HOSTIP = 192.168.0.11 

• APPMGMT_HOSTNAME = LBLACK.americas.foods.com 

• APPMGMT_PID = 1900 

• APPMGMT_STANDALONE = Y 

• APPMGMT_PHASE_NAME = install 

The following are examples of HP-UX values: 

• APPMGMT_BYTEORDER = bigEndian 

• APPMGMT_MACHINE = 9000/800 

• APPMGMT_OS = HP-UX 

• APPMGMT_OSCOMMONNAME = HP-UX B.11.00 

• APPMGMT_OSSSERVICEPACK = N/A 

• APPMGMT_OSVERSION = B.11.00 
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• APPMGMT_PLATFORM = unix 

• APPMGT_HOSTIP = 192.168.0.11 

• APPMGMT_HOSTNAME = LBLACK.americas.foods.com 

• APPMGMT_PID = 1900 

• APPMGMT_STANDALONE = Y 

• APPMGMT_PHASE_NAME = install 

The following are examples of Solaris values 

• APPMGMT_BYTEORDER = bigEndian 

• APPMGMT_MACHINE = sun4u 

• APPMGMT_OS = SunOS 

• APPMGMT_OSCOMMONNAME = SunOS 5.9 

• APPMGMT_OSSSERVICEPACK = N/A 

• APPMGMT_OSVERSION = 5.9 

• APPMGMT_PLATFORM = unix 

• APPMGT_HOSTIP = 192.168.0.11 

• APPMGMT_HOSTNAME = LBLACK.americas.foods.com 

• APPMGMT_PID = 1900 

• APPMGMT_STANDALONE = Y 

• APPMGMT_PHASE_NAME = install 
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B Application Management Profiles 
Standalone Agent 

A command line utility, standalone agent,  is available on the installation 
media to test a Master Application Profile (MAP) or Custom Application 
Profile (CAP). Use the standalone agent to execute profiles without the 
OVCM Infrastructure or to test the profile. The standalone execution runs as 
the logged on user. 

The standalone agent, includes the following arguments: 

• The –xml parameter is used to specify the profile you want to test. 

• The -mode parameter is used to specify the phase you want to run in the 
test. The possible values for mode are create (application installation), 
delete (application removal), verify (verification of application 
components), repair (repairing broken applications), and update (for 
updating an application). If mode is omitted, it will default to create 

• The -idmlib parameter specifies the location to build the CM objects. If 
this parameter is not specified, the CM objects are built in the location of 
the appcntrl.tkd. If idmlib is omitted it will default to either 
IDMROOT, if the CM agent or CM Administrator is installed, or the 
current directory, if the CM agent or CM Administrator is not installed. 
Of course, this also depends on what directory option is chosen in the 
command itself. 

• The –logfile parameter allows you to set an alternate log file. The 
default is appcntrl.log. 

 
Be aware that this will not work for all Application Management 
Profiles. A Profile that is designed to run locally may succeed. 
However, if the Profile has dependencies between phases, then you 
will need to run all of those phases to get a reliable result. In other 
words, this is not guaranteed to work for all Profiles. Always run the 
Profile in a test environment before moving to production. 

To test a profile 

1 Load any media that the profile requires to the appropriate directory. 
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2 Copy the profile to the same directory as the CM Server Management 
Agent on the test device. 

3 Open a command prompt, and navigate to the directory where the CM 
Server Management Agent and the profile have been loaded. 

4 Type the following command: 

nvdkit appcntrl.tkd –xml filename.xml –mode modetotest 

The profile runs, and executes any commands that the profile indicates. All 
actions are logged to appcntrl.log in the same directory as appcntrl.tkd. 
Messages are appended to the end of the log with the most recent entries at 
the end. 

For testing the verify phase, you should following these steps: 

• Break the application. 

• Run this utility with –mode verify. 

• Confirm that the application was found to be broken by checking 
appcntrl.log. Also check that the log is reporting the correct error. 

As an option, run the utility with –mode repair.
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C Product Name Changes 
If you have used Radia in the past, and are not yet familiar with the newly 
rebranded HP terms and product names, Table 5 below will help you identify 
naming changes that have been applied to the Radia brand. 

Table 5 Product Name and Term Changes 

New Name/Term Old Name/Term 

CM agents Radia clients 

CM Application Management Profiles Radia Application Management Profiles 

CM Server Management Agent Radia Server Management Client 

HP OpenView Configuration Management Radia 

HP OpenView Configuration Management 
Administrator AMP Editor 

Radia AMP Editor 

HP OpenView Configuration Management 
Administrator 

Radia Administrator Workstation 

HP OpenView Configuration Management 
Admin CSDB Editor 

Radia System Explorer 

HP OpenView Configuration Management 
Admin Packager 

Radia Packager 

HP OpenView Configuration Management 
Application Manager 

Radia Application Manager 

HP OpenView Configuration Management 
Configuration Server 

Radia Configuration Server 

HP OpenView Configuration Management 
Configuration Server Database 

Configuration Server Database, Radia 
Database 

HP OpenView Configuration Management 
Portal 

Radia Management Portal 

HP OpenView Configuration Management 
Solutions for Servers 

Radia Server Management 
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